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 OmegaT (OT) is a free open-source CAT Tool that is being used by DGT for prototyping since 2012, prior to 
the acquisition of a commercial CAT tool.  

For that purpose, the 2.6.0_3 version of OmegaT was customised and extended to integrate other DGT tools (called 
internally DGT-OmegaT to differentiate it from the public version). 

In June 2012, DGT-OmegaT and its Project Wizard were made available to all translators interested in trying/using it.  

DGT has in the meantime updated its OmegaT version to the 3.1.2 public version (DGT-OmegaT 2014). 

As OmegaT has evolved quite a lot in the last 2 years  and the full Guide is getting bigger all the time…   this 
Quick Guide aims to give you basic information so that you can start translating with OmegaT right away with a 
minimum of effort. 

But if you want to know more about OmegaT features in general or some feature in particular, see the relevant 
section(s) in , which is available by clicking on 
Guides in the OT Project Wizard. 

For translators who already used DGT-OmegaT 2012, there are a few minor changes, but basically it is the same… 
with improved/new features, of course. 

 

Screenshot 1 — DGT-OmegaT 2014 
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 Furthermore, DGT has developed in-house an OmegaT Project Wizard to integrate OmegaT in its workflow 
and this Quick Guide includes the basic information you need to manage your projects. 

 

 

Screenshot 2 — DGT-OmegaT Project Wizard window and features 

 

DGT-OmegaT Project Wizard (OT Wizard) makes the link between Tradesk  our document management system 

 and OmegaT.  

The OT Wizard helps you to easily and quickly create and update projects with new original documents/new versions 
and/or new memories, delete documents/memories from the project, add glossaries, organise translation memories 
and archive finalised projects.  

It also triggers automatic backups (every 10 minutes) of your active project to a server (your space in the H: drive) in 
a background operation you don’t see. 

Furthermore it makes it easy to share memories in real time (either with colleagues working with OmegaT or the 
mainstream CAT tool) by easily connecting to the in-house TeamBase application.  

The OT Wizard is easy to use as  for many of the project management operations  it just opens a Windows 
Explorer window and there you can copy, paste, delete, drag/drop and rename files in the usual manner.  

For a general explanation of the OmegaT Wizard features, see Section 6 of this Quick Guide. To optimise its use, see 
DGT OmegaT-2014 and its Project Wizard — A Translator’s Guide for more detailed information. 



DGT-OMEGAT AND ITS WIZARD — Quick Guide — MJM — September 2014 — DGT-OmegaT-3.1.2_3+DGT Extensions 2.1. beta update 2 

 

4 

 

This is a brief overview of OmegaT features to give you a general idea of how it works. 

1 – : We work within projects, which may have one or several/many documents — with 

hundreds or thousands of pages on the whole — that are treated in a single project in a speedy way, even when 
there are successive new versions during the translation of the project. Each document is individually identified so 
that you always know where you are. 

 These documents can be: 

a) One, some or all documents of large packages (European Semester, Budget, Rail, Multiannual Financial 
Framework, for example) with different dossier and part numbers (Example: RTD-2014-80020-00-00 + 
RTD-2014-80020-00-01 + RTD-2014-80021-00-00 + RTD-2014-80023-00-00) 

b) Documents of dossiers with numerous parts (like a model contract with several parts),  

c)  SRC files (usually Excel or PowerPoint files with tables, graphs), 

d) Documents with a number of new versions (quite frequent), 

e) Several small documents which you may want to gather in a project (like several replies to parliamentary 
questions, cartouches) even if unrelated, just to save time, 

f) Any combination of these.  

If your documents have a subfolder structure, OT will keep it. You can also easily change the order in which 
OT displays the documents in your project. 

In the present implementation of DGT-OmegaT, the source Office documents are not converted to xliff format. 
So you have as source the original Office document and you save your translation to the project memory. 

2 –  The documents to translate may be in different formats (Word, Excel, PowerPoint, 

x(html), etc.), but they will all be displayed the same way as “raw” text in the Editor pane, i.e. segments stripped 
of their formatting.  

3 – With Budget documents, there is no problem, 

you can use OmegaT. With Recast documents, it is not possible to use OmegaT and you will have to use the 
old TWB.  

4 - : Inline formatting is displayed in the form of tags (Example: <t0/>).  

 You will only see what is called inline tags (i.e., tags inside the segment) and not all the tags related to styles or 
to the whole segment.  

By hovering with the mouse over each tag, you will see its description (in a very cryptic way!). It is mostly useful 
to see if it is a footnote (which is not to be missed!). 

 If you want, you can also translate with Remove Tags activated, which means that you won’t have any tagsat 
all in the documents … but afterwards you (or the Unit secretariat) will have to add the formatting manually in 
the native application. 

 To work without tags, in the Project  Properties menu, tick the Remove Tags box. You can change your 
mind at any time (as the tags are only hidden, not removed). But it is not recommended to change from tags/no 
tags mode in the middle of a project. Some segments you already translated will be “orphans” because they will 
no longer match (tags included) the segments in your document. Those segments will therefore be displayed 
as untranslated in the Fuzzy Matches pane. 

5 – : All the documents in your project are, by default, automatically merged and 

treated as a whole. The auto-propagation of the translation of identical source segments (non-unique 
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segments) is done automatically for the whole project — in a background operation you don’t notice — and 
those segments are displayed greyed. 

OT numbers the segments sequentially from the first segment of the first document to the last segment of the 
last document, but it displays the name of each individual document in the Editor ribbon so that you always 
know what document you are working on.  

6 – : OT cannot have several documents open at the same time, but as it treats 

your project globally, its powerful Search feature will search in all the documents inside your project — no 
matter how many they are — and the Fuzzy Matches (in OT, Fuzzy Match comprises 100% matches) pane will 
display matches from all the documents in the project.  

 You can also do Search/Replace in all the documents of your project.  

7 – : In OT, there are 2 segment statuses — untranslated and translated. All translated 

segments are stored in the project memory and are available for Fuzzy Matches. 

8 –  OT provides statistics for the documents within your project and match statistics for the whole 

project and for each document, with the indication of repetitions in documents and between documents, 
something which is very useful if a project is to be split between translators.  

It also provides statistics of how much you have already translated and what remains to be translated. Besides, 
it displays and continuously updates the number of (unique) translated/non translated segments, by document 
and for the whole project. 

You also have automatically copied to your project main folder an Excel sheet — Personal Statistics — in which 
you can record your progress in the translation of your project.  

9 – : OT preferences are 1-level and OT will “remember” the last preferences you set when you 

close and reopen it, either with the same project or with another project. Of course, you can easily change the 
preferences at any time. 

10 – : There are several options (display only target or source and target 

segments; mark non-unique segments, segments with notes, translated segments, non-translated segments, 
modification info, etc.).  

You can choose at different stages of your translation to have them displayed differently just by clicking or 
unclicking that option in the View menu. When the option is active, the coloured box is marked with a line 
around it. 

11- : In the Options  Fonts menu, you can also change the size and font of the display — in the 

Editor and in the other panes — depending on what you find more comfortable.  

12 – : You can minimize or maximize each pane by double 

clicking on the ribbon of each pane and selecting the option you want.  

You can also undock the panes by selecting that option, clicking on the mouse right button and  keeping it 

pressed over the ribbon  dragging the pane to the position you want. The only pane that cannot be undocked 
is the Editor. 

If you want to return to the default pane display, in the Options menu, select Restore Main Window. 

13 – : You cannot print the document as seen in the Editor, you can only print the document in its native 

application.  

14 – : Use the Upload feature of Tradesk to copy, at the end or any time during the 

translation process, your translated document(s) from your computer to Tradesk.  

 If the documents are to be sent to the requester, you may have first to do Save As and choose the Office 2003 
format. This is temporary as DGT will (hopefully soon) only work with the new Office formats. 

15 - : You can access further information on OmegaT and its 

Wizard by clicking on Guides in the OT Wizard. There you have the Guides concerning DGT-OmegaT and its 
Wizard and the Guides for the public version of OmegaT.   
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1 - : If you are a teleworker, OmegaT will not slow you down as it is not a 

resources-hungry application and backups are done in a fast background process without you noticing it.  

 If you are not a teleworker, but you sporadically need to translate at home, you can use OT just by copying it to 
your private computer (of course without access to DGT databases) as there are no license issues. 

2 - Projects can be easily created locally, directly in OmegaT, in the case of 

documents that cannot be transmitted via the network (SECEM documents, for instance).

3 – : You can share memories in real time using the DGT TeamBase 

application. With it, you can control when and how you want to work in share mode, depending on your working 
method.  

You can share the segments you translate from the very beginning of your translation just by connecting to the 
TeamBase of your project and, if you want, of other projects that may be ongoing.  

You can also decide to only share your segments when you consider that they are already sufficiently “good” to 
be of any use to others, but even so you can receive segments translated by others. This feature is particularly 
useful if you first do a fast draft translation which you afterwards improve. 

4 – : You can use DictaTrans or Dragon Dictate as usual.  

5 – : When creating a project, the OmegaT Wizard will do an automatic backup of it to your personal 

space in the H: drive: H:\CAT\OmegaT_Projects. This copy is to be used in case there is a problem/crash in 
your computer and you need to use the backup. 

This backup is automatically updated every 10 minutes - in a background process without interrupting your work 
- for the active project defined in the Project field of the OT Wizard. Therefore, don’t close the OT Wizard after 
opening a project! 

Furthermore, OT itself does automatic backups of your project every few minutes (saved locally in the \omegaT 
subfolder of your project), so the risk of losing any of your work is minimal (I never had any problems).  

6 – In DGT, the starting point to create (or update) a project with one or several documents is always to 

use the Local copies option in Tradesk to copy to your PC/laptop the original documents to be included in the 
project.  

By default they are copied to the C:\Users\{your login}\AppData\Local\Local Documents-no backup\DGT\Dossiers 
folder. 

7 – : The OT Wizard will create the OmegaT project in a subfolder of C:\Users\{your 

login}\AppData\Local\DGT\OmegaT_Projects default folder. 

8 – : You can create as many subfolders as you want in the project folder  for 

example, to have monolingual reference documents which can be used for Search or to gather any other 

information, either technical or administrative   but you cannot delete any of the subfolders that were 
automatically created for each project. If you do, OT may not work properly.  

9 – : The OT Wizard will create the OT project with the original document(s)  wiping useless 

tags in the process (TagWipe)— and the respective memory (tmx) files available for download in Tradesk: 
retrievals, aligned reference documents and machine translation, if any (pre-processed for EN-other 
languages). 

The OT Wizard will create the project making TagWipe and segmentation rules project-specific. Therefore, if 
any of them are changed/improved by the IT Unit during the translation of a lengthy project with (many) new 
versions, there will be no change in those rules and therefore you won’t have in your project unduly 
untranslated segments. 
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10 – : You can update your project at any time during the translation process with new original 

documents and/or aligned reference documents (see Section 6) without the need to create a new project.  

If you update your project with new documents or new versions of documents already in the project, when you 
reopen the project, the 100% segments (including formatting) that you had already translated — which are in 
your project memory in the \omegat subfolder — will be automatically displayed in the Editor pane as translated 
without any other action on your part. 

11 – : If you are translating documents with language combinations which are not 

automatically machine-translated, you will have to request machine translation. Do not forget to select the tmx 
format.  

After receiving the MT file by email, copy manually  to the project \mt subfolder  the tmx file(s) you receive.  

12 – : You can organise your 

memories by subjects in subfolders of the \tm folder —  something which might be very useful when you are 
translating large projects with many reference documents — and give them priorities (for instance, EU Treaties 
have precedence over Regulations and Directives, but these have precedence over Communications, Reports, 
etc.).  

 OT reads the memories/subfolders in the \tm folder by alphanumeric order and you can number your 
documents or subfolders to give them priority. 

13 – : You can also use reference memories with 

the same source language but with a target language other than that of your project. That may be useful for 
terminology purposes if there is a previous translation into another language of the same (or of a similar) 
document that can be used as reference (you can give it a penalty to it, if you want). 

14 – It gives you complete control over the reference memory(ies) you want to use for 

pre-translation. You just have to copy one or more tmx file to \tm\auto subfolder of your project and the 100% 
(including tags) segments will auto-populate your documents and be highlighted in a background colour to call 
your attention to the fact that they were automatically transferred to your project memory. They will remain so 
highlighted unless you change that segment and “make it your own”.  

 You can use pre-translate before starting translating a project or any time in the middle of the process. In the 
latter case, only untranslated segments in your project memory will be pre-translated. Segments you had 
already translated in your project will remain untouched. 

When you Update a project with a new version of an original, there is no need to do pre-translate as your 
translated segments are all in the project memory and will be automatically inserted in the new versions (if they 
are a 100% match including tags) without any action on your part.  

15 – : The first time you create a terminology entry in your project, OT will automatically create a 

glossary for that project, which is the writeable glossary.  You can also define one — and only one — glossary 
that you already have as your writeable glossary, i.e. the glossary in which your new entries will be stored.  

 If you have one or more glossaries you want to use in your project, you can just copy it/them to the \glossary 
subfolder of your project to use as read-only. For instance you can use an IATE extraction (source term and 
target term) - as I do - with 0.5 million or more entries and not lose “speed”.  

16 - You - and your reviser - can do all the revision work using OT, although some 

manipulations will be necessary as the workflow is not automated.  

 The reviser can include notes in problematic segments and the changes introduced can be searched and filter 
(by login/date) and displayed with track-changes in the target (instead of the source) segments so that the 
translator can easily see the changes made by the reviser.  

 However, in OT you cannot accept only part of the changes in a particular segment: it’s either the whole revised 
segment or your previous translation … and therefore it may involve some typing.  

 

https://mtatec.ec.testa.eu/mtatec/
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1 – : You can only write in the open segment; you cannot write anywhere else in the source or 

target segments of your document(s). There is always a segment open in the OT Editor pane.  

 Segments are validated with <Enter>. OT keeps only the last modified version of each segment in the project 
memory.  

2 – : The one that matters in 

terms of content is the first percentage. The last one takes account of formatting (Match: <71/57%>). 

3 – : You can access these DGT applications directly in OmegaT just by 

clicking on the respective icon.  

4 – : It is really worth exploring the powerful OT Search feature.  

You can search — by exact search, keyword search and regular expressions, strings, whole words and 
lemmas, by author and by date — in source or/and target segments in your project (translated and/or 
untranslated) and/or in the translation memories and/or in glossaries,.  

Furthermore, you can also search monolingual documents in the formats accepted by OmegaT (e.g. Office and 
PDF).  

In the same window, you can also filter, by those criteria, segments in your project and have them displayed in 
the Editor pane for editing, by clicking on Filter at the bottom of the Search window. 

5 – : You can do a Replace Interactive (one by one) or a Replace all in all the documents of 

your project using the same options as in Search text (exact search, keyword search, regular expression, case 
sensitive, strings, whole words and lemmas) and “preview” the segments affected before launching the 
replacement operation. 

6 – : Footnotes are treated as end notes and are always displayed at the end of your 

document. There is no visible "link" (besides a non-descriptive tag, if you are translating with tags) between 
them and the respective paragraph. However, they will be correctly displayed in the translated documents … as 
long as you have inserted the respective tag in the relevant segment. 

7 – : You can have notes linked to particular segments in your document 

which are displayed in the Notes pane when that segment is open. When closed, those segments are 
highlighted with a background colour (pink) in the Editor (default).  

 Neither this highlight nor the actual notes will be transferred to the Office document. However, you can “export” 
all your notes to a file, if you want to discuss them with another colleague/reviser. 

8 – 

: The first translation of a segment that appears 2 or more times in one or more documents inside 

a project is automatically propagated in all the other repeated segments (non-unique segments) and OT 
considers it the default translation. These segments have the status “translated” and are counted as such in the 
statistics.  

Take into consideration that, if you afterwards change its translation in any one of the segment’s occurrences, 
all the other identical segments (in all the project documents) will automatically and instantaneously be 
changed, in a background operation you don’t see, without any need for confirmation or search, search/replace 
on our part ... but also without any warning.  

So, if you want the translation of a particular instance of a non-unique segment to be different and not changed 
automatically if any other of its occurrences is changed, you can define it as an alternative translation — 
which applies only to non-unique segments in that particular document — by clicking on it in the target segment 
with the mouse right button or selecting it in the Edit menu.  

9 – : OT does not allow to easily merge or split 

segments in the Editor. There is a way to do it but it is not straightforward.  
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10 – : In OmegaT you can omit formatting that is present in the 

source segment but you cannot add formatting which does not exist in the source segment. You will have to 
add that formatting in the final translated document in its native application. 

11 – :  These are segments that you already translated — and which are therefore in your 

project memory — but which no longer exist in the documents in your project.  

This may happen when you delete — for some reason — a document from your project or when you update a 
project with a new version of one or more documents (and delete the previous version).  

These segments will be displayed in the Fuzzy Matches pane (with its match rate) and identified as “orphans”. 
They are displayed first according to the match rate. 

12 – : The terms/strings with a blue 

linear and bold underline (by default) mean that there is an entry in one of the glossaries (displayed in the 
Glossary pane) of your project.  

By right clicking on the mouse, the translation(s) of that term/string will be displayed in a dropdown menu. You 
can select to insert it at the position of the cursor in the target segment in the Editor by clicking on it. 

If you don’t want to see all those blue underlines, in Options TransTips, unclick Enable TransTips. Then 
you won’t see the blue underlines, but the entries will continue to be displayed in the Glossary pane as long as 
there is a glossary in the \glossary subfolder of your project. 

13 – : It allows you to complete words from glossaries or auto-text (your own list of 

abbreviations for instance), to add (special/foreign language) characters and also to manage tags. You can add 
entries and customize its display.  

14 – : You can check the spelling in all the documents of your project and update your dictionaries 

of ignored or learned words. 

This update is recorded in a sort of “dictionary” files that are language specific and which are used for all your 
projects. 

15 – : You can check your documents for a series of possible errors: check for inconsistent 

numbers, shorter target, equal source and target, untranslated segments, etc. 

16 – : You can view it directly from OmegaT by selecting the Source file in the 

Project menu. 

17 – : There is no (real-time) Preview, but you can easily and 

quickly open your document in its native application by creating the translated document(s) and opening 
it/them. 
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1 – Copy the 2010 Office format already available in Tradesk as ORC (docx) to your computer. If not available, open 
the document(s) and do a Save as in the 2010 Office format (docx, xlsx, pptx…).  

2 – Click on the OT Wizard icon - - in your desktop (automatically created in the installation of OT) to open it. 

 Note: If it is not your first project, select Clear before starting the creation process. 

3 – Select the source and target languages from the dropdown menu (if not already defined). 

4 – Click on Add — which by default will open a Windows Explorer window in the Dossiers folder — to select the 
original document(s) previously copied to your computer. You have to select them one by one, even if they are in 
the same folder. If they are in different folders, navigate the folder structure to reach and select all the original 
documents. 

5 – In the Windows Explorer window, click on Cancel or press ESC when you have finished selecting the documents. 

6 – By default, the OT Wizard will give to the new project the number of the first document you added to the list, but 
you can change it — in the Project field — writing a name meaningful to you (for example: RTD-Innovation-
Partnerships-2013). 

7 – Click on Create and the OT Wizard will create the OmegaT project with the structure you see below.  

 

Screenshot 3 — OmegaT project structure 

8 – Click on Open (which is displayed in green when the project has been created) and it will open that project in 
OmegaT.  
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Note: This is the basic information you need to translate a project. See also Section 5 for a list of main functions, shortcuts and 
icons. 

1 – OT starts by displaying the list of the documents in your project. Click on Close to accept the opening of the first 
segment of the (first) document. You are now ready to start the translation of your first project.  

If you want to translate another document, just do Ctrl+L (or select Project Files in the Project menu) and the 
list will be displayed again and you can select the document you want.  

You can also change here the order in which OT displays the documents in your project. 

2 – To see the statistics of your project before beginning your translation, select — in the Tools menu — the option 
you want: Statistics, Match Statistics or Match Statistics per file. Those statistics are stored in the project 
\omegat subfolder. 

Getting Statistics is a fast process, but Match Statistics (per file) can take a while if you have a big project 
(hundreds of pages). The good thing is that you can do it any time! 

3 – OT displays the first segment to be translated and, by default, if there is a Euramis match above 80% (or a 
different threshold of your choosing), it will be automatically inserted in the segment open for translation.   

If you want to use Machine Translation (which is displayed in the MT pane) even when an Euramis match has 
been automatically inserted in the target segment, just press Ctrl+M to replace it by the MT output.  

If there is no match, OT will display the MT output (by default). You can deactivate the automatic insertion of MT 
in Options  Editing Behaviour, by unticking Insert Machine Translation. It is here that you can also select 
the Minimal Similarity threshold for the automatic insertion of Fuzzy Matches. 

4 – To insert in the target segment an Euramis match other than the first (higher) match displayed in bold in the 
Fuzzy Matches pane, position the cursor on the Fuzzy Match segment you want to use, right click on the 
mouse and choose the option you want from the drop down menu: To Insert Match into Translation or To 
Replace Translation with Match.  

 You can also double click on the Fuzzy Match segment you want (which will turn to bold as the selected 
segment) and use the shortcuts Ctrl+R or Ctrl+I. 

5 – Translate/correct your first segment and press Enter to validate it and to open the next segment for translation. 

6 – If you want to go to another segment (far) above or below, just scroll/go to that segment and double click on it to 
open it for translation. OT will save the previous segment to the project memory and open the new selected 
segment.  

7 – You can copy/paste, drag/drop between the Fuzzy Matches, Search and Editor panes and from applications 
outside OT.  

8 – To use DocFinder, Quest or Euramis, just highlight the term/string/OJ reference you want to search and click 
on the icons or use the shortcuts (Ctlr+Shift+D, Ctlr+Shift+Q or Ctlr+Shift+E, respectively). 

9 – To insert a tag, position the cursor where you want the tag to be inserted and press Ctrl+T. OT will insert the 
first or next missing tag in that position. You can also right click the mouse and choose the tag you want from 
the dropdown menu. There are still other ways to do it. 

10 – To search terms/strings in the project and/or the reference translation memories and/or glossaries, highlight 

them in the Editor pane, press Ctrl+F and press Enter to accept the defaults  or select the setting you want 
in the Search window. It will search for terms according to the settings. There are many options worth exploring. 

11 – You can Search / Replace all or one by one (Replace Interactive) by doing Ctrl+K or clicking on Search and 
Replace in the Edit menu.  

12 – To create a glossary entry, highlight the source term you want and press Ctrl+Shift+G (or go to the Edit menu 
and click on Create Glossary Entry) and fill in at least the first 2 of the 3 fields available (source term, target 
term and comments).  
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If it is the first entry you create in that project — and you have no previous glossary in the \glossary folder of 
your project — OT will automatically create a glossary for the project.  

If you want to delete or change an entry in your writable glossary, press Ctrl+Shift+F2 to open the glossary in 
Notepad++ for editing. 

13 – The terms/strings with a blue linear and bold underline mean that there is an entry in one of the glossaries in the 
\glossary folder of your project (which are displayed in the Glossary pane). By right clicking the mouse, the 
translation(s) of that term/string will be displayed in a dropdown menu.  

 You can select to insert it at the position of the cursor in your target segment by clicking on it. Terms displayed 
in bold belong to the project glossary. 

14 – To use the Auto-Completion feature, press Ctrl+space and cycle through the options by doing Ctrl+Page 
Down to select the option you want.  

To add a new entry for auto-text (abbreviation), select Options  Auto-completion   Auto-text and add 
your new entry. To add a character to the character table, select Options  Auto-completion   Character 
table. 

15 – After finishing your translation, or at any time during the translation process, click on the icon 16 (Validate tags) 
or press Ctrl+Shift+V and see if OT detected anything wrong/missing. By clicking on the number of the 
segment in the window that is displayed on the left, OT will jump to the segment in question and open it in the 
Editor pane and you can correct it if needed.  

The Validate tags check is sometimes overcautious. There are tags that you may ignore... but others not!  

If there is a tag at the very beginning or end of a segment, or tags before and after a full stop in segments that 
should have been split, don’t even think of what they mean, just insert them, in the same position, in the target 
segment or otherwise it may happen that your translated documents will not be generated. 

Concerning paired tags — for italics, bold, underline — if you insert only one of them, your document will 
probably not be generated in its native format. However, if you don’t insert both, the only problem is that the 
particular word/string will not have formatting in its native application. 

Concerning footnotes, if you don’t insert the tag in the target segment, the footnote will not appear in the 
translated document in its native application, although you have translated it. So, be careful! 

However, if you are working with Remove Tags activated, the footnotes will be in the right place at the bottom 
of the right page and the number of the footnote will be at the end of the right paragraph … but maybe not in the 
right position. You will have to check and eventually change it correct it in the translated document in its native 
application. 

16 – You can do the spellchecking in your whole project by clicking on Ctrl+Shift+F7 or selecting it in the Tools 
menu. 

You can also add learned or ignored words one by one by right clicking on the mouse and selecting Ignore all 
or Add to dictionary. 

17 – You can do a quality check of your project — QA Check Rules — by clicking on Ctrl+Shift+F3 or selecting it in 
the Tools menu. You can choose the type of “errors” you want to detect by ticking/ unticking each box. 

18 – To create the translated document(s) in their native application(s), press Ctrl+D to generate all the target 
documents or Ctrl+Shift+D to generate only the document you are working on. They are generated in the 
project \target subfolder.  

It is better to do Validate tags before creating one or more translated documents. But if you don’t, OT will 
generate them — even if without some formatting — except if essential tags are missing (see point 15 above). If 
so, correct them and generate the document(s) again. 

19 – If you want to view one or more of your translations, open the project folder (Ctlr+Shift+F1 or select that option 
from the Tools menu), select the \target subfolder and click on the document you want and it will be displayed 
in its native application. 
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20 – You can generate the formatted document as many times as you want, taking into consideration that any 
changes you make directly (formatting or content) in the generated target document will not be transferred to 
the OmegaT project memory.  

21 – Every time you repeat the Create Translated Documents command, OT will replace — in the \target subfolder 
— the previously translated document(s) with the updated one(s). So don't make any changes in the 
document(s) in their native application unless you are sure you won't use OT again for the translation of that 
particular document. 

If you have a translated document open in its native application, that document will not be updated. So, close 
the/all document(s) before generating translated documents. 

22 – If you are working with projects with a (large) number of documents and/or with different deadlines — and you 
make changes in it/them directly — it may be “wise” to create a new subfolder in your project and save your 
document(s) to that subfolder so that they are not replaced by any subsequent creation of translated 
documents.  

 It is not advised to make changes in a document in its target application without uploading it to Tradesk first. 

23 – To copy the translated document(s) to Tradesk — at any moment during the translation or to be sent to the 
requester — upload the translated document(s) using the Tradesk Upload function.  

The translated document(s) are in the project subfolder \target of your project which is in System  (C:) — 
Users — {your login} — AppData — Local — DGT — OmegaT_Projects. Make it a Favourite! 
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Functions and shortcuts: As in most applications, you can use the menus (with the full features) or the shortcuts 
(for many operations). Below are listed some of the most frequently used.  

DGT icons: DGT IT Unit has added some icons for the most common operations, which are self-explanatory (place 
the cursor on them and a text will appear). 

 

     1      2      3      4       5      6      7      8      9      10    11     12    13    14     15    16     17    18    19    20 

Function Icon Shortcut Information 
New project 1  Usually created with the OT Wizard 

Open project 2 Ctrl+O Usually opened with the OT Wizard 

Reload 3 F5 
If you add or delete new documents, or add glossaries or dictionaries, to an OT project 
directly in OT without using the OT Wizard, you have to reload. 

Close project 4 Ctrl+Shift+W Closes the project, but not OmegaT. 

Undo last action 5 Ctrl+Z Only within the open segment 

Redo last action 6 Ctrl+Y Only within the open segment  

Search project 7 Ctrl+F To search terms/strings with many options 

Search and Replace 8 Crtl+K Search/replace all or one by one. 

Go to previous 
segment 

9 
Ctrl+P 

 

Got to next segment 10 Ctrl+N  

Go to next untranslated 
segment 

11 
Ctrl+U 

 

Go to the next 
Untranslated segment 

 
Ctrl+Shift+U 

 

Replace with match 12 Ctrl+R Replaces the target segment with the match you select in the Fuzzy Matches pane. 

Insert match 
13 

Ctrl+I 
Inserts in the target segment, at the position of the cursor, the match you select in the 
Fuzzy Matches pane. 

Replace with Machine 
Translation 

14 
Ctrl+M 

Copies to the target segment the MT output that is displayed in the MT pane and 
replaces what is there. 

Insert Next Missing Tag  Ctrl+T 
Inserts the first (or the next) missing source tag in the target segment at the position of 
the cursor. 

Insert source tags 15 Ctrl+Shift+T Inserts all the missing source tags in the target segment at the position of the cursor. 

Validate tags 
16 

Ctrl+Shift+V 
Shows the list of segments that have missing, different or surplus tags in the target 
segment. Clicking on the segment number, OT jumps to that segment in the Editor for 
editing. 

DocFinder 17 Ctrl+Shift+D Highlight the reference to search and it opens DocFinder 

Quest 18 Ctrl+Shift+Q Highlight the term/string to search and it opens Quest 

Euramis 19 Ctrl+Shift+E Highlight the term/string to search and it opens Euramis 

Quit 20 Ctrl+Shift+Q To quit OmegaT 

Open project Folder  Ctrl+Shift+F1 Within OmegaT, to open the project folder in Windows Explorer 

Insert glossary entry 
 

Crtl+Shift+G 
To create a new glossary entry (OT automatically creates of a new project glossary if 
there is none) 

Open writable glossary  Ctrl+Shift+F2 To open the glossary in Notepad++ to change or delete entries. 

Spellchecker  Ctrl+Shift+F7 To detect spelling mistakes and learn/ignore words in the whole project 

Quality check  Ctrl+Shift+F3  To carry out several levels of quality check 

Auto-completion  Ctrl+space Glossary Entries, Auto-Text Entries, Missing Tags and Character Table 

Auto-completion-cycle  Crtl+Page Down Cycle between Glossary Entries, Auto-Text Entries, Missing Tags and Character Table 

Statistics  Tools Menu Statistics within the project documents, Match Statistics and Match Statistics per File 
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The OmegaT Project Wizard will help you to quickly and easily manage your OmegaT projects — creating, updating 
and modifying them — by interfacing with Tradesk, Windows Explorer and OmegaT.  

The starting point to create (or update) a project with one or several documents (with the same or different dossier 
numbers) is always to use the Local copies option in Tradesk to copy to your PC/laptop the original documents to 
be included in the project.  

By default they are copied to the C:\Users\{your login}\AppData\Local\Local Documents — no 
backup\DGT\Dossiers folder).  

Note:  As OmegaT doesn’t accept the Windows 2003 formats DGT is still using, copy the original ORC 
now available in Tradesk (docx). 

If you have Excel or PowerPoint originals in the Windows 2003 format that you want to use in the 
project, do a Save as in the new format (xlsx, pptx) before creating the project. 

To manage your project, you can click on the buttons or use the shortcuts (ALT + character underlined, for example 
ALT+A). 

  Note:  If the first character of each option is not underlined, just click on Alt to activate the shortcuts. 

1 – Click on the OT Wizard icon – – in your desktop, if it is not open.  If OmegaT is open, close it. 

2 – If a previous project is active (with its name in the Project field), click on Clear before creating the new project. 

3 – Define the source and target languages (if necessary). 

4 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you 
previously copied to your computer. In multidocument projects, repeat the operation to add them one by one. 
Click on Esc, or Cancel in Windows Explorer, when you have finished selecting documents. 

5 – By default, the name of the new project will be the name of the first document added and it is displayed in the 
Project field, but you can change it to whatever you wish (for example, Budget2013).  

6 – Click on Create.  

7 – The Wizard will create the OmegaT project in a subfolder of the OmegaT_Projects default folder (System  (C:) 
— Users — {your login} — AppData — Local — DGT — OmegaT_Projects) with the original(s) you selected 
— wiped of useless tags (TagWipe) — and the respective memory files and MT output available in Tradesk.  

 The OT Wizard assumes that, in the majority of cases, you will want all the memories that are available in 
Tradesk. As there are no speed or capacity problems, you can afford not to be selective. But if you want you 
can afterwards delete the ones you don’t/no longer want in your project. 

8 – Click on Open and it will open OmegaT and that particular project.  

 

If you want to work in share mode with other translators working on the same project: 

1 – After opening the project, click on TeamBase in the OT Wizard. 

2 – Select a memory from the list displayed or create a new shared memory.  

 By default the name of the new memory displayed is the name of the active project, but you can change it. 

3 – Click on Connect to in order to work in share mode with colleagues who are working on related documents. 

4 – You can start working on your project. 
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You can give priority to memories or groups of memories (for instance, Financial Regulation legislation, Horizon 2020 
legislation) in an easy way so that: 

 In the Fuzzy Matches window, the matches are displayed by order of match rate (in ascending order) and, 
with identical match rate, by the order of preference you gave to those memories or subfolders.  

 In the Search window, the segments are displayed by the order in which the tmx files were ranked.  

To organise your memories: 

1 - You don’t need to close OmegaT if you have it open in that particular project. 

2 – In the OT Wizard, click on Browse and select the \tm subfolder of the active project you want to manage.  

 There you have all the translation memories that were automatically copied to your project by the OT Wizard 
when the project was created or updated.  

3 - Using Windows Explorer features, you can rename tmx files (for example 22013D0743-EN_EN-PT-AL, 
32013R1290-EN_EN-PT-AL) or create subfolders in the \tm subfolder of the project - to where you can copy or 

drag and drop the tmx files you want to use as reference - and give those subfolders the name and priority you 
want (for example 1-Horizon2020, 2-Financial Regulation). 

 You can also just copy/paste folders you have in your PC with thematic translation memories and you can change 
at any time the priority given to those memories or subfolders without the need to do Reload. 

4 - It is also here that you can delete translation memories that you don’t/no longer need. 

5 - You can resume your work if that project was open. If not, click on Open in the OT Wizard.   

You can add at any time new documents or versions of documents to a project in a simple way.  

The segments you had already translated are stored in the project memory and are automatically inserted 
(pre-translated) in the new document/version of your document(s) if there is a 100% match (including tags) without 
any action on your part. 

1 – If OmegaT is open, close it. Select the project to be updated by clicking on Select, if it is not the active project.  

2 – Check that the source and target languages are correct. If not, select the correct ones. 

3 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you 
previously copied to your computer. In multidocument projects, repeat the operation to add them one by one.  

4 – Click on Cancel in Windows Explorer, or press Esc, when you have finished selecting your documents. 

5 – If new version(s) of existing document(s) are added, in the OT Wizard click on Browse, select the \source 
subfolder and delete the previous version of the original document(s) if it is no longer needed (usual situation).  

6 – Click on Update. 

7 – Click on Open when the update is finished and the OT Wizard will open OmegaT and that particular project.  
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If you don’t want to add any new documents, but just add aligned reference memories that you have requested via 
Tradesk after creating the project, the procedure is basically the same as described in point 6.3. 

1 – If OmegaT is open, close it. Select the project to be updated by clicking on Select, if it is not the active project, 
and check the source and target languages.  

2 – Click on Add — which will open a Windows Explorer window — to select the original document(s) that you had 
previously copied to your computer and which are related to the new aligned reference memories you want to 
copy from Tradesk to your project. 

 If the memories relate to documents which are part of a single dossier, you just have to add one of the 
documents in that dossier and the OT Wizard will copy all the new memories to the project. If it relates to 
different dossiers, select one document from each dossier. 

3 – Click on Cancel in Windows Explorer, or press Esc, when you have finished selecting the documents to which 
those memories refer to.  

4 – Click on Update. 

5 – Click on Open when the update is finished and the OT Wizard will open OmegaT and that particular project.  

If you have thematic or reference memories in your computer — for instance, from a previous project — that you 
want to use in a project, you can easily do it. 

1 – There is no need to close OmegaT or that project if it is open. Select the project to be updated by clicking on 
Select, if it is not the active project, checking that the source and target languages are correct. 

2 – Click on Browse and select the \tm subfolder of that project.  

3 – Copy to it the memory files in your computer to be included in that project with copy/paste or drag & drop (from 
another Windows Explorer window).  

4 – You can resume your work if that project was open. If not, click on Open in the OT Wizard.   
 

If you don’t have a glossary you want to use in the project — when you first create a glossary entry — OT will 
automatically create a glossary for that project (the writeable glossary) which is stored in the \glossary subfolder of 
that project.  

If you have personal/Unit/Department glossaries that you would like to use in your project, you can adapt them to be 
used in OT.  

The format OT accepts is the following simple txt file with 3 fields separated by tabs and ended by a carriage return 
(the last field is optional):  

 <tab> <tab> <Return> 3rd field with whatever you like or empty

To add one or more glossaries to your project: 

1 – There is no need to close OmegaT or that project if it is open.  

2 – Click on Browse and select the \glossary subfolder.  

3 – Copy/paste the glossary(ies) to that subfolder.  

4 – In OmegaT, do Reload (F5). 

5 – Resume your work. 
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1 – Automatic backups are made when a project is created — and they are updated every 10 minutes — to the 
H:\CAT\OmegaT-Projects folder, which has automatic backups by the IT Unit.  

 In case of problems in your computer, the project backup folder can be copied to another computer or your 
repaired computer and be used without any conversion. You just open the project with OmegaT (Wizard) and 
resume your work.  

2 – Manual backups — By clicking on Backup in the OT Wizard, you can manually update the backup any time 
you want. 

Guides available in the OmegaT Wizard: 

1 — In-house Guides: 

 The present Quick Guide 
 DGT-OmegaT-2014 and its Project Wizard — A Translator’s Guide 
 DGT-OmegaT and its Project Wizard — A Translator’s Guide (2012). For translators who were already using 

the 2012 version. 

2 — Guides for the public OmegaT version. Take into consideration that DGT-OmegaT has some adaptations: 

 OmegaT 3.0 — User's Guide by Vito Smolej (the Guide in the OmegaT Help, but in pdf for easier 
consultation) 

 OmegaT for CAT Beginners by Susan Welsh & Marc Prior 


